
From the Editor:

The major announcement this month was iBook Author. Lots of meetings this month so this will be short.

Tom Ostertag, Publications Director
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 TC Photoshop User
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 Avenue So, Minneapolis

 Jeff Tranberry

 Board of Directors
 Meeting
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 Mac Consultants SIG  Good Day Cafe, 5410 Wayzata Blvd., Golden
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 mini’app’les Annual
 Meeting

 Penn Lake Library, 8800 Penn Ave, Bloomington  Tim Drenk, 952-479-0891

 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave.,
 St. Paul

 Harry Lienke,
 qasig@miniapples.org
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 Steve Wilmes, 651-458-1513

* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.

Meeting Calendar – February 2012Meeting Calendar – February 2012Meeting Calendar – February 2012Meeting Calendar – February 2012
Thursday February 2 7:00 pm Mac Applications SIG
Tuesday February 7 7:00 pm Mac OS X SIG

Wednesday February 8 7:00 pm VectorWorks SIG*
Wednesday February 8 7:00 pm TC Photoshop User Group*

Monday February 13 7:00 pm Board of Directors Meeting
Tuesday February 14 7:00 pm iOS SIG
Thursday February 16 7:00 am Mac Consultants SIG
Saturday February 18 1:00 pm mini’app’les Annual Meeting
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Thursday February 26 6:30 pm FileMaker Pro SIG
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mini’app’les Annual Meeting
by Jeff Berg

The mini'app'les Annual Meeting will be held on 
Saturday, February 18. The meeting is scheduled 
from 1:00 pm until 4:00 pm at the Penn Lake 
Library, 8800 Penn Avenue in Bloomington.

We will begin the meeting with a presentation or 
speaker (yet to be finalized), followed by annual 
reports and nominations for club officers. All 
members are encouraged to attend.

Membership Help Needed!
by Les Anderson

Our membership coordinator is retiring and we need 
a replacement. The Membership Coordinator 
maintains the FileMaker data base of our members. 
New members are entered and a membership card is 
produced. Membership renewal notices are also sent 
to members. These forms are generated within 
FileMaker. Most of this is done via e-mail. If a 
member pays with a check, it is deposited in our 
TCF account.

Meeting attendance is not required.

If you can help, or want more information contact 
Les Anderson, Membership Director, or Tim Drenk, 
Club President.

iOS SIG Meeting • 10 January 2012
by Joel Gerdeen

An iOS SIG meeting was held at 7 pm on Tuesday, 
January 10 at the Southdale Library. 
This SIG focuses on iOS 
devices such as iPhones, iPad 
and iPod Touches. We 
discussed remote desktop apps 
that run on iOS to remotely view 
and control Mac and Windows 
desktops.

A comparison matrix of 10 apps and 31 features was 
presented. A Keynote presentation summarizes the 
remote desktop apps and features compared.

This comparison should be considered a partial 
starting point as there were 94 remote desktop 
related apps in the App Store and there was no time 
to research them all. Most of the comparison was 
based on App Store or web page information since it 
would be costly to buy them all. Three apps, 
SplashTop Remote, LogMeIn Ignition and Parallels 
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Remote were demonstrated in actual remote control 
operation. The following links will get you to iWork 
copies of the presentation and matrix including more 
links to other remote desktop app information and 
comparisons.

http://public.iwork.com/document/?
d=Remote_Desktop_Comparison_-
Jan_2012.numbers&a=p38447935

http://public.iwork.com/document/?
d=iOS_SIG_Jan_2012_Presentation.key&a=p38447
935

The next meeting is planned for Tuesday, February 
14 at 7:00 PM at the Brookdale Library Study Room 
1 meeting room. Note that this meeting location is 
a change from previous meetings. The meeting 
will continue discussion of previous apps and any 
interesting apps released during the month. For those 
interested, the meeting will continue at a local 
restaurant (TBD) afterwards.

MacApps SIG Meeting Report • 5 January  
2012
by Tim Drenk

We looked at using styles in Pages, Word, and 
InDesign and some general formatting guidelines. 
Styles are templates that can apply multiple 
character and paragraph formatting options in a 
single click. Using styles saves time when creating 
text and when editting or changing the text. After a 
style has been applied to text, if the style is changed, 
the text will change as well. Styles provide an easy 
way to keep formatting consistent in a longer 
document and between multiple documents. 

There are two main types of styles: paragraph styles 
and character styles. Paragraph styles apply to the 
entire paragraph and only one paragraph style can be 
applied at a time. Character styles apply to 
individual characters so there can be multiple 
character styles within a single paragraph.

Styles in Pages ’09
The default styles can be viewed by selecting “Show 
Styles Drawer” from the View menu or the View 
drop down menu on the toolbar. The Styles Drawer 
shows each type of style separately. Character and 
list styles can be hidden by using the buttons on the 
bottom right. Pages keeps list styles separate while 
Word and InDesign treat them as paragraph styles.

To apply a style, select the desired text and click on 
the desired style. All formatting options in that style 
will be applied to the text.

To create a new style, use the + button at the bottom 
left of the Style Drawer. A single click will create a 
new paragraph style based on the current text and 
style. Click and hold on the button to have the option 
to create the other style types. There is also “Create 
New Paragraph Style from Selection…” in the 
Format menu.

To change a style in Pages, make the formatting 
changes in the text. Then use the drop down menu 
on the right side of the style and select “Redefine 
Style from Selection”. There is no way to directly 
change the style.

Styles can brought into the current document from 
different document by using the “Import Styles…” 
in the Format menu. Importing styles saves time by 
not having to recreate them and it maintains 
consistency between multiple documents.

Styles in Word 2011
Styles in Word 2011 can be found in several places. 
Like older versions, all existing styles can be found 
by selecting “Style…” in the Format menu and in the 
Toolbox under the Styles tab. Word 2011 adds the 
Ribbon which contains the “Quick Styles” area. 
There is an option at the bottom of the “Modify 
Style” dialog box to have the style included in the 
“Quick Styles”.
Word lists both paragraph styles and character styles 
in the same list. The paragraph mark or the character 
mark (an underlined a) on the right side indicates 
what kind of style it is.
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To create a new style, click on the “New Style…” 
button in the Toolbox or the “New…” button in the 
Style dialog box. The “New Style” dialog box 
contains all the formatting options that can be set. 
Word gives the option to base a style on an existing 
style. This gives the ability to make a style with all 
the characteristics of the other style with whatever 
changes you make. Be aware that any changes to the 
base style will affect any style that uses it.
Word also gives the ability to specify which style 
will come after the current style using “Style for the 
following paragraph”. One example of using this 
would be a question and answer type document. 
Suppose I create two styles named Question and 
Answer. For the Question style, I mark Answer as 
the “Style for the following paragraph”. For the 
Answer style, I mark Question as the “Style for the 
following paragraph”. After I enter my question text 
and press return, all the formatting that I want for the 
answer paragraph will automatically be applied for 
the next paragraph. After entering the answer text 
and press return, the formatting for the next 
paragraph will automatically change back to 
question formatting. Using this technique, creating a 
numbered FAQ with indented answers becomes very  
easy.
To modify an existing style in the in the Toolbox, use 
the drop down menu on the right side of name. Note 
that the drop down menu doesn’t appear until the 
cursor is over the style name. The formatting dialog 
box appears and any changes can be made. The 
“Modify…” button in the Style dialog brings up the 
same dialog box for the selected style.
Styles can be moved between documents through the 
Organizer dialog box which can be opened from 
button at the bottom of the Styles dialog box. Styles 
can also be added to templates.

Styles in InDesign CS5.5
InDesign offers the most options and flexibility 
when working with styles. Paragraph and character 
styles each have separate palettes and can be created 
and edited there. Along with being able to specify a 
base style and a following style, InDesign allows for 
nested character styles. Nested styles will 

automatically change the character style based on the 
criteria set. For example, suppose I want the first 
sentence in a paragraph to be bold, the second 
sentence to be italic, and the third to be bold again. I 
can create a style which applies those changes 
automatically as I type each sentence.

Formatting guidelines
Many of the guidelines for typing that were taught 
when typewriters and basic word processors with dot 
matrix dominated are outdated and no longer apply. 
For example, using a typewriter with a monospaced 
font (all characters take the same amount of space), 
the guideline is to use two spaces at the end of a 
sentence after the period. Now with proportional 
fonts, the guideline is to use only one space after a 
sentence. The guidelines were created because of the 
limitations of the technology—such as a typewriter. 
With newer technology—such as word processor 
like Pages and Word—the guidelines are different. 
Here are a few:
• Use bold or italics to add emphasis, do not use 

underlining.
• Avoid using ALL CAPITALS because they are 

harder to read.
• When using proportional fonts and not 

monospaced fonts, use one space after a sentence 
and not two spaces.

• Use the word processor feature of adding space 
before or after a paragraph, do not use multiple 
returns to create space. Using multiple returns 
creates too much space between paragraphs and is 
laborious to change.

• Use either the space before/after a paragraph or 
indent the first line to indicate a new paragraph, 
but not both. Both are visual cues for a new 
paragraph so using both is redundant.

• Use the word processor feature of changing the 
line height to add or remove space between lines. 
This is called leading or linespace.

• Set the tab stops and type of tabs(left, center, right, 
decimal) and indents to where you want them. Do 
not use multiple tabs together or multiple spaces to 
move text over.
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• Use en dashes “–” (Option and -) and em dashes 
“—” (Shift, Option, and -). En dashes (named 
because it is same width of a capital N in the 
current font) are used when specifying a range, 
such as “Pages 4–7”, or a relationship, such as 
“post–computer”. Em dashes (named because it is 
same width of a capital M in the current font) are 
used in sentences for a break in thought or a 
interpolation—usually something stronger than a 
parentheses.

Putting it all together
Styles are designed to save time when creating and 
editing a document. Obviously, in a short document, 
directly applying formatting is the best option. In a 
longer document or across documents, styles are a 
very useful and efficient tool. Instead of having to 
individually change a particular format option in 8 
different paragraphs in a 6 page document, using 
styles, I can change the style and all 8 paragraphs 
will be changed at once.
Using the correct formatting, makes a document 
look professional and well done. Some of the 
guidelines are subtle, but they add to the overall feel 
of the document. Perhaps people can’t directly 
identify why a document looks professional or not, 
but they are still aware of it.

New Q&A SIG Coordinator
by Harry Lienke

On January 25 I was drafted to be the Question and 
Answer Special Interest Group (Q&A SIG) 
coordinator replacing Chuck Hauge. Chuck now has 
job responsibilities that prevent him from making a 
regular commitment to the SIG, so he asked to pass 
his SIG responsibilities to someone else.

The Q&A SIG will continue to meet on the fourth 
Wednesday of each month in Conference Room B of 
the Merriam Park Library located at 1831 Marshall 
Avenue in Saint Paul (corner of Marshall and 
Fairview). The next meeting is scheduled for 
February 22.

The roots of this SIG are in the Novice SIG of 
yesteryear. I hope our meetings will have a good 
mixture of less experienced Mac-ophiles to provide 
questions and more experienced Mac-ophiles to 
provide answers. I will strive mightily to keep our 
discussions on topics of interest and usefulness to 
the less experienced users and at a level of expertise 
appropriate for those users.

If you have questions or topics you would like to 
have us discuss, please send me an email at 
qasig@miniapples.org so we can prepare 
appropriately and provide an informative 
presentation.

Please support the mini’app’les by bringing any and 
all questions to the Q&A SIG.

See you there!

Strategies for Switching from Word to Pages
by Tonya Engst 

Last year, when the Take Control ebook series 
migrated from Microsoft Word 2008 to Pages ’09, I 
faced the challenge of not only acquainting myself 
with an unfamiliar piece of software, but also of 
helping a group of authors make the switch, all while 
under time pressure to keep up with Apple’s 
breathless product-release schedule. (If you are 
curious about why we chose to switch, or about our 
EPUB-savvy production process, see “How Take 
Control Makes EPUBs in Pages,” 30 September 
2011.)

Now that the commotion from the transition has died 
down, I want to share the strategies we used in 
switching from Word to Pages, along with some of 
my favorite Pages tips.

Look at the Bottom -- A classic mistake of the long-
time Word user switching to another program is to 
assume that if you look long enough in the menus 
and dialogs, you’ll encounter all the important 
commands available (that’s even more true if you 
include Word’s Tools > Customize Keyboard dialog, 
which lists a wealth of obscure commands). In Word, 
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you can use the menus and dialogs as training 
wheels and pretty soon you’ll start using keyboard 
shortcuts for commands that you choose often.

This approach failed dismally in Pages. In Pages, 
key functions are stuck hither and thither in the user 
interface and there is no apparent reference that lists 
them all.

Important options appear at the lower left of a Pages 
document, in a location that is precariously close to 
the Dock with a full-height Pages window and a 
horizontal Dock. I’ll explain the three options I use, 
but note that there is also a checkbox in the Pages 
General preference pane to show the word count in 
this lower area; I work with that turned off.

The leftmost pop-up menu lets you change your 
zoom level and how many pages are showing at 
once. Although Pages does have a Zoom command 
in the View menu, it won’t let you choose a specific 
zoom percentage and it lacks the pop-up menu’s 
One-Up and Two-Up commands that control how 
many pages appear. I like to work at 100% with two 
pages showing, but many other Take Control folks 
prefer a higher zoom level in only a single page, so 
each time one of us opens the file, the zoom and 
display layout must be adjusted, which can be done 
only from this little pop-up menu.

The Pages area in the bottom window border turns 
out to be clickable. Click it, and a “Go to Page” box 
appears where you can type the page number that 
you want to move to. Again, you can’t access this 
navigational control from any normal menu, dialog, 
or keyboard command.

The Scroll To triangles and associated gear menu 
that appear next are incredibly valuable. You use the 
gear menu to set what the triangles do. For instance, 
they can advance you to the next comment in the 
document, or the next hyperlink. If you want to 

quickly flip through all the comments in a document, 
this is the only place to be.

Reveal Hidden Track Changes Toolbar -- Another 
popular chunk of interface real estate for a group of 
people working on a document is the Track Changes 
toolbar, which you can bring up by choosing Edit > 
Track Changes or by clicking the Track Changes 
button on the main toolbar. The Track Changes 
button isn’t present on the main toolbar by default, 
but you can customize the toolbar with View > 
Customize Toolbar or by Control-clicking it and 
choosing Customize Toolbar, just like in other Apple 
applications.

The Track Changes toolbar has two pop-up menus 
on its right side that most Take Control people failed 
to spot on their first few rounds of writing or editing. 
The View Markup menu controls the extent of 
tracked changes that you can see, which is essential 
for hiding your tracked deletions (you might think 
you could hide them using the Deleted Text menu in 
Pages’ General preference pane, but you’d be 
wrong). The gear menu gives you commands to 
accept or reject changes wholesale, and it is useful 
for picking the color of your change-tracked text. (I 
have a great deal of fun monkeying with the colors; 
the second figure below shows Adam editing in 
purple and me editing in green; comments are 
always in yellow.)
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To establish a comfortable workflow with the 
commands available only in the Track Changes 
toolbar, I had to extend myself outside the confines 
of Pages because I needed keyboard shortcuts for 
some of its functions, particularly for accepting 
changes and for toggling track changes on and off, 
both functions that I might invoke hundreds of times 
in a typical day. I finally turned to Keyboard Maestro 
to create macros that give me keyboard shortcuts for 
those actions.

Inspect the Inspector -- The Inspector is a panel 
that comes up if you choose View > Inspector 
(Command-Option-I) or click the Inspector button 
on the toolbar. Many Pages options are available 
only from the Inspector, and the Inspector has a bank 
of tiny buttons at its top, which you click to switch 
between the different panes of options. I find 
working with the Inspector easy now, but for the first 
month it felt slow and cumbersome.

Frustratingly, each of the Inspector panes is a 
different size. I like to keep the Inspector open, for 
faster access, but it seems that as soon as I get it in 

the right spot on my screen, I switch panes and it 
becomes the wrong size for that spot. Some authors 
get around this by opening multiple copies of the 
Inspector with View > New Inspector. Personally, I 
wish the Inspector would open to one size and then 
lock onto an edge of the Pages window in a neat 
way, as palettes in InDesign do, since all too often I 
wind up with it in the way of something else. (Word 
has a similar problem with its Formatting Palette, but 
since most of its functions are available in other 
ways, you can keep it closed most of the time.)

Rummage around in the Styles Drawer -- Another 
exciting chunk of Pages real estate is the Styles 
drawer, which can be opened from the View menu, 
with a keyboard shortcut, from a button on the 
Format bar, or with a non-default toolbar button. 
Within the Styles drawer, it took me a while to 
realize that an accurate hover over the right of a style 
name would reveal a tiny triangle pop-up menu and 
it also took a while to be able to reliably click that 
minuscule menu on the first click. It all seems easy 
now, but at first it required persistence.

Eventually, I made that menu open enough times and 
absorbed its capabilities to the point where I tried the 
Hot Key command, which lets you assign a function 
key (like F3, say) to a style, so that you can apply it 
by pressing a key on your keyboard. However, most 
of the Take Control crew already had our function 
keys assigned to other functions. Third-party 
software again came to the rescue, this time in the 
form of AppleScripts for popular styles — each 
writer could install the scripts on his or her Mac and 
then use a macro utility (such as Keyboard Maestro 
or QuicKeys) to assign a keyboard shortcut to each 
script. In case you’d like to try this, here’s an 
example:
tell application "Pages" 
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 set mySel to (get selection of front document) 
 set paragraph style of mySel to "Chapter Name" 
end tell 

(Chapter Name is the “Heading 1” style that you 
must assign to your top level headings when 
exporting an EPUB from Pages.)

Although we read the manual and searched high and 
low in Pages, we’ve yet to find a way to configure a 
paragraph or list style by hand, by selecting the 
various attributes that we’d like it to include. This is 
sort of possible when creating (but not editing) a 
new character style by choosing Create New 
Character Style from Selection from the None 
character style’s pop-up menu and then expanding 
the Include All Character Attributes control. But 
there is no equivalent to the technique in Word 
where you choose Format > Style, then click New or 
Modify. Instead, you must make a paragraph or list 
look the way you want and then redefine the existing 
style. Wacky.

My Kingdom for an Outline! -- A great feature in 
Word, and one that I am sorry to have left behind, is 
the Navigation bar, which has been given different 
names in different versions of Word, all while 
remaining functionally the same. You open it as a 
left-hand bar in the Word window, and it shows the 
outline of your entire document, as long as you’ve 
used Word’s built-in heading styles (any experienced 
Word user would use those built-in styles — they are 
Word’s crown jewels with their elegant integration 
with the Table of Contents feature and full, useful 
Outline view).

In Word’s Navigation bar, you can see the “forest” 
surrounding the “trees” of what you are reading at all 
times, and you can even edit the headings right in the 
Navigation bar. So, if you are in the middle of a 
chapter and deeply into a set of Heading 3 level 
topics, and suddenly the manuscript starts alternating 
between Heading 2 and Heading 4 level topics, you 
know you are in trouble and can adjust immediately. 
You can also click any line in the Navigation bar to 
jump to the corresponding heading.

Alas, Pages has no such organizational navigation 
interface, Also, because Pages has neither a Back 
command after clicking a link nor any other sensible 

way to jump back and forth between two sections of 
a document, we are finding it challenging to get 
around in longer documents.

To simulate the Navigation bar in Pages, some of us 
have taken to displaying the View > Page 
Thumbnails bar at the left, expanded as large as 
possible (drag its right border). It gets large enough 
that you can read the text in its thumbnails. I like to 
open it to the table of contents pages, so I can see the 
“outline” there, and sometimes I open another copy 
of the manuscript in a separate document window so 
that I can more fully view the outline or a second 
portion of a manuscript.

Unfortunately, all of these workarounds pale in 
comparison to Word’s Navigation bar and, frankly, 
the quality of the link-based user navigation in the 
Take Control series has decreased slightly because of 
this, because it is so much more difficult for authors 
and editors to determine where a possible link might 
lead.

Find the Documentation -- Another classic strategy 
for learning a program deeply is to read the manual 
or some other form of documentation. I have read 
the entire Pages manual, and I found it frustrating 
because while it does document how Pages is 
supposed to operate, it doesn’t clarify which features 
that you might expect in a word processor are not 
present. (To be fair, very few programs document 
their shortcomings.) Also, I’ve found some features 
to be a bit dodgy, most notably section breaks and 
style modifications, and I can’t figure out if it’s me 
or a bug in Pages; the manual doesn’t provide 
examples or describe common use cases.

You can find the manual by choosing Pages > Help, 
but if you plan to refer to it often, I suggest 
downloading the PDF and storing it somewhere 
handy.

A useful resource for ebook publishers is a short 
document published by Apple called “ePub Best 
Practices for Pages,” which you can download from 
a link in the Apple support note “Creating ePub files 
with Pages”. The document mentions the handful of 
styles that you need to use in a Pages document 
slated for EPUB export and notes the all-important 
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fact that graphics in such a document must be inline, 
not floating.

It took time to learn that the best way to place a 
figure-sized graphic as inline is to first create a 
paragraph formatted so that the “Line” is “At Least” 
a specified line height; the “At Least” setting allows 
the line height to increase to the height of the 
graphic (open the Inspector, click the T (for Text) 
button, click the Text button). Once you have the 
proper line height format set, press Command while 
you drag the image file in from the Finder.

Another useful resource is the Pages Apple Support 
Community, which I’ve visited several times to ask 
questions and to try to help out by answering a few. 
If you have Pages questions, this is a good place to 
ask.

Work with Great People -- Although it was fairly 
easy to write this article, it was not easy to learn 
everything that I’ve mentioned in it. It would have 
been all the harder had I not been part of a small 
working group of smart and good-spirited people 
who could commiserate with my woes and 
sometimes point out options that I’d overlooked.

I could write a great deal more about the fine points 
of Pages and working with change tracking, about 
how I had to make a macro in order to insert a 
comment without the timestamp being pre-
highlighted (such that when you start typing the 
timestamp disappears, unless the first key you press 
is the Right arrow key), about Pages versus Word 
templates, and more, but I have covered the main 
high (and low) points for now. If you have a Pages 
tip to share, please let us know in the comments.
This article is copyright © 2012 Tonya Engst TidBITS is 
copyright © 2012 TidBITS Publishing Inc. Reuse governed by 
Creative Commons License.

How I Dared to Try iTunes Match and 
Actually Enjoyed It
by Matt Neuburg 

After the initial public unveiling of iTunes Match 
(see Adam Engst’s “iTunes 10.5.1 Unveils iTunes 

Match,” 14 November 2011), I went through the six 
stages of denial: I was confused about what it was, I 
was certain it was something I’d never want to try, 
and so on. My main objection was that it looked to 
me as if a lot of stuff was going to happen 
automatically, and I found that scary. Whatever 
iTunes Match is, it has something to do with my 
music, and I’ve spent years collecting and tagging 
that music; I don’t want anything bad to happen to it. 
I like to be in control. So I decided to ignore iTunes 
Match.

Then, after a while, I got over it and started doing 
my homework. In particular, I read a really splendid 
article over at Macworld. At first, I didn’t understand 
it. Then I read it again. And again. And after a while 
I started to get the idea.

What I chiefly understood was this: The main benefit 
of iTunes Match is, exactly as Adam had said in his 
article, that it “enables you to store [your music] in 
the cloud and then play it from any of your 
computers or iOS devices.” So I could keep, say, 50 
GB of music in the cloud, and listen to it on a 16 GB 
iPhone, even though there isn’t room for it all on the 
iPhone. In fact, there hardly has to be room for any 
of it on the iPhone; it’s in the cloud. That is 
something I did want to be able to do. At the very 
least, I wanted to try it.

But I wanted to try it gradually. I certainly wasn’t 
going to approach iTunes Match with my entire 
music library and say, “Here, iTunes Match, stick 
this in the cloud.” For one thing, I have 200 GB of 
music and a rather lame, slow-on-the-uptake DSL 
connection. For another, there’s a 25,000-track limit, 
and my library goes way over that. Finally, I didn’t 
want to hand iTunes Match my real music, because I 
didn’t want it to come to any accidental harm.

So I started out with a simple goal: get the complete 
works of Mozart into the cloud, safely, as an 
experiment. Here are the steps that I followed.

Copy the Music -- Everything starts on my 
computer, with iTunes. What’s going to be important  
here are the music files. I didn’t want to hand my 
normal music files to iTunes Match; I wanted to 
hand it copies.
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So, in the Finder, on the Desktop, I created a folder 
called Mozart. In iTunes, I opened the playlist 
containing all my Mozart, selected all the tracks, and 
dragged them from iTunes to the Mozart folder on 
the Desktop. The result is that all my Mozart tracks 
were copied to the Mozart folder. Those are the 
copies I wanted to hand over to iTunes Match.

Make a Separate Library -- It’s a little-known but 
crucial fact that you can have more than one iTunes 
library — they just can’t both be active at the same 
time. If you launch iTunes while holding down the 
Option key, it asks what folder contains your iTunes 
library, along with an offer to make you a whole new 
iTunes library folder. So I did that. I had iTunes 
make a new library in a new folder called iTunes 
Match, in my Music folder, right next to my normal 
iTunes library folder, which is called simply iTunes.

At this point I was running iTunes and it had no 
music at all — because the iTunes Match library was 
totally new. The new library folder contains all the 
various files and folders that make up a complete 
iTunes library, plus it has its own preferences. So, in 
the Advanced preferences, I turned off the option 
that says “Copy files to iTunes Media folder.” My 
goal was to show iTunes some music, and have it put 
that music in the cloud, but no more; I didn’t want it 
to keep an additional copy of my music.

Make Some Temporary Music Storage -- In the 
Finder, I created a new folder in my Music folder 
called Music Temporary. Into Music Temporary, I 
dragged the Mozart folder that I’d previously created 
on the Desktop. From there, I dragged the Mozart 
folder into the sidebar in iTunes.

The result was that the new iTunes library, iTunes 
Match, now knew about my Mozart tracks and 
nothing else. And what it knew about was a copy, 
living in a specific location (the Mozart folder in 
Music Temporary). That was going to be crucial later 
on, as you’ll see.

Turn On iTunes Match -- Still working in the 
iTunes Match library, I signed up for iTunes Match. 
That’s very easy: you click the iTunes Match listing 
in the sidebar under Store and tell it your Apple ID 
and password. Instantly it sucks the money ($25) 

right out of your iTunes account, and voilà: iTunes 
Match is running.

(I also later discovered that I had received a nice 
email informing me about the money being sucked 
out of the account.)

Go To Bed, Twice -- The exact details of this step 
are optional, but you’re going to want to do 
something time-consuming at this point, because 
iTunes is now going to analyze your music and start 
uploading it to the cloud. I reckoned that, given the 
size of my Mozart collection and the narrowness of 
my upload bandwidth, this could easily take all 
night, so I went to bed. In the morning I discovered 
that I was perfectly right: in fact, iTunes hadn’t even 
half-finished uploading my Mozart.

Since I needed my Internet connection not to be 
bogged down with uploading music during the day, I 
quit iTunes. Then, that night, before going to bed, I 
launched iTunes again and chose Store > Update 
iTunes Match. iTunes picked up where it had left off 
previously, and continued uploading my Mozart for a 
second night.

Be Amazed on an iOS Device -- The next morning I 
woke up feeling as if it were Christmas. Okay, that’s 
because it really was Christmas. But I also had found 
that iTunes was finished uploading my Mozart. I was 
ready to discover What Hath iTunes Match Wrought.

With trembling fingers I picked up my iPhone and 
launched the Settings app. Under Music are two 
switches: iTunes Match and Show All Music. I set 
them both to ON. iTunes threatened to delete all my 
existing music on the device, but I just laughed 
fiendishly, since that was all part of my cunning 
plan. I had already signed up for iCloud on this 
device, using the same Apple ID I had used to sign 
up for iTunes Match on my Mac. So my iPhone 
should now magically see all that Mozart. Would it?

(I think that right around this moment the iPhone 
asked me for the password that goes with my Apple 
ID — I’m sorry I can’t remember exactly when that 
was. Anyway, I entered it when asked.)

I quit Settings and launched the Music app, and 
switched to Albums. I could see from the activity 

mini’app’les Newsletter — February 2012 Page 10 of 20



indicator in the status bar that the Music app was 
communicating across the Internet. I waited, and 
after a while… there it all was! My Mozart tracks 
are carefully tagged and organized into albums; well, 
there were all those albums, apparently sitting in my 
Music app — except that each album had a little 
cloud icon in its listing. I tapped an album and there 
were the tracks; and each of them had a little cloud 
icon as well. Then I tapped a song, and, after a heart-
stopping pause, it started to play.

What’s more, it kept on playing. I had started in an 
album, so the Music app did what it always does 

when you play a song in an album: it went 
seamlessly on to the next track in the album.

The really amazing part is that this also works with 
apps that were written before iTunes Match came 
along, and that know nothing of its existence. Take, 
for example, my own Albumen app. Its purpose is to 
overcome the truncation limitations of Apple’s 
Music app interface, by showing me the full titles of 
all my albums, and the full titles and artists of all 
their tracks — as well as letting me play and pause a 
track. Well, incredibly, after I’d run the Music app 
once to update the device’s library, Albumen then 
showed me all my Mozart albums and tracks, even 

mini’app’les Newsletter — February 2012 Page 11 of 20

http://itunes.apple.com/us/app/albumen/id355128672
http://itunes.apple.com/us/app/albumen/id355128672


though none of them were actually present on the 
device; and if I tapped a track, it started to play.

The only thing Albumen gets wrong is this: Behind 
the scenes, the way all this cloud-based playing 
works on an iOS device is that when you start 
playing a track from an album, iTunes starts 
downloading that track (so it can play it) and the 
next track (so it can segue seamlessly into it when it 
reaches the end of the current track). Those two 
tracks, the current and subsequent track, are always 
missing from Albumen’s display. I presume that 
eventually Apple will provide new ways for app 
developers to have their apps survey the Music 
library so as to take account of this new cloud-based 
behavior.

Throw Away the Music -- My Mozart was now in 
the cloud. That was where I wanted it. So I no longer 
needed that special copy of all my Mozart songs that 
I had made merely for the purpose of handing them 
to iTunes Match.

So now I did something very bold. I returned to 
iTunes on my computer, which was still sitting there 
displaying my special iTunes Match library 
consisting of all my Mozart. I selected all that 
Mozart and pressed Option-Delete to remove it from 
my iTunes Match library! iTunes presented a 
confirmation dialog containing a checkbox asking 
me whether I also wanted to remove those tracks 
from the cloud. But of course that was exactly what I 
did not want to do, so I didn’t check that checkbox.

My iTunes Match library in iTunes was now empty 
once again. But those Mozart copies were still sitting 
in the Mozart folder in Music Temporary, taking up a 
lot of space. So now I threw caution to the winds and 
put that Mozart folder into the Trash, and emptied 
the Trash. (Remember, even they were duplicates of 
my real music files, which are backed up every 
which way from Tuesday.)

Meanwhile, back in my special iTunes Match library, 
I got another surprise, and a very pleasant one at 
that. The Mozart tracks that I had just deleted were 
all still listed here under Music — marked with a 
cloud icon, just like the tracks on the iPhone! And 
there they remained, reminding me that these tracks, 

though no longer present on my computer (as far as 
this iTunes library knows), are stored in the cloud; 
indeed, if I wanted to, I could actually play them 
from the cloud, or even, by clicking that cloud icon, 
download them back to my computer.

Finally, I quit iTunes, started it up with the Option 
key held down, and told it to open my normal iTunes 
library once again.

I had done it! Everything on my computer was 
exactly as it was before. iTunes looked the same as 
before; and remember, this iTunes library knew 
nothing of iTunes Match. The amount of space on 
my hard disk was not reduced; I had made copies of 
all the Mozart, but then I had deleted those copies. 
But my Mozart was now in the cloud, and I could 
play it from any iOS device, or even from some 
other Mac.

Lather, Rinse, Repeat -- Over the next few days I 
followed the same steps all over again, except that 
now I didn’t need to make a new iTunes Match-
aware library (I already had one) and I didn’t need to 
sign up for iTunes Match again (I’m good for a 
year). I quit iTunes and launched it again with 
Option held down, and opened my special iTunes 
Match library. I handed it a copy of some other 
composer’s music. I chose Store > Update iTunes 
Match. I went to bed.

The result is that all my Beethoven, Mozart, Brahms, 
and Dvorak are now in the cloud. On future 
evenings, I’ll probably be uploading the works of a 
few more of my favorite composers.

Music Management on the Device -- Okay, now 
here’s a problem. Apple’s interface for managing 
music on an iOS device, when that music is cloud-
based music, is not very good. Each time you play a 
track, it is not only streamed but downloaded and 
stored on the device. (That’s different from what 
happens on a Mac, where you can just stream from 
the cloud to listen.) This is exactly what we were 
trying not to do: gradually, as you listen to music 
from the cloud, the iPhone is filling up with actual 
tracks for which there isn’t enough room.
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What you’d like to do, from time to time, is to delete 
from the iPhone the tracks that are actually present 
on it. That’s not easy because Apple hasn’t provided 
a good way of locating them. Here’s my admittedly 
somewhat awkward solution: Go back to Settings, 
and under Music, turn off iTunes Match. Now open 
the Music app again. Under Songs, only tracks that 
are physically present on the device are displayed. 
Swipe to delete each of them. The track remains, but 
it is then marked with a cloud icon, indicating that it 
isn’t really on the device. Finally, in the Settings app, 
turn iTunes Match back on.

Dude, Where’s the Matching? -- You may have 
noticed that I’ve said nothing about the “match” in 
iTunes Match. The idea is that instead of uploading 
all your music to the cloud, for some of your tracks, 
at least, Apple may be able to supply a copy of the 
very same tracks from its own vast music holdings, 
thus saving you some time and bandwidth.

That aspect of iTunes Match doesn’t interest me very 
much, however. Some people may be happy that 
those matched copies are 256 Kbps AAC, which 
may be better than the quality of the copy on your 
computer; but my music is already ripped at that bit 
rate (I can hear the difference when it’s compressed 
further).

Also, my music is not the kind that Apple generally 
keeps a copy of. Of about 5500 tracks that I’ve 
handed over to iTunes Match so far, only about 3500 
were matched automatically; the other 2000 had to 
be uploaded over a series of several nights. I’m not 
saying that’s insignificant; after all, it’s better than 
half, which makes the difference between, say, three 
nights of uploading and six nights of uploading. But 
in general I wasn’t expecting to be terribly impressed 
with this aspect of the procedure, and sure enough, 
I’m not. Your mileage, as they used to say, may vary.

What I am impressed by is, as I’ve already said, the 
virtual presence of all that music on my iOS devices 
that in reality are too small to hold it. The seamless 
display of the cloud-based material exactly as if it 
were sitting on the device is an utterly successful 
illusion. I can hardly wait to whip out my iPhone 
during a discussion of some musical phrase and say, 

“You know the piece I’m talking about, it goes like 
this! What? You don’t carry the complete works of 
Beethoven, Brahms, and Mozart wherever you go?” 
I’m already practicing a withering look of pity 
mixed with contempt. Of course, if my interlocutor 
is a Spotify Premium subscriber, or has iTunes 
Match as well, that look may have to go unused.
This article is copyright © 2012 Matt Neuburg, TidBITS is 
copyright © 2012 TidBITS Publishing Inc., Reuse governed by 
Creative Commons License.

Apple Goes Back to School with iBooks 2, 
iBooks Author, and iTunes U
by Adam C. Engst 

In a special event in New York City, Apple’s Senior 
Vice President of Worldwide Marketing Phil Schiller 
and VP for Productivity Software Roger Rosner 
unveiled a pair of free apps aimed at reinventing the 
textbook market: iBooks 2 and iBooks Author for 
the Mac. Not content to stop there, Senior VP of 
Internet Software and Services Eddy Cue and VP of 
iTunes Jeff Robbin then introduced the free iTunes U 
app for iOS.

iBooks 2 -- iBooks 2 is an update to Apple’s free 
ebook reading app for the iPad, enabling users to 
read specially created enhanced ebooks containing 
rich multimedia elements and interactivity, along 
with gorgeous layouts. Apple is focusing the new 
capabilities of iBooks on the textbook world, where 
videos, interactive images, 3-D graphics, and 
embedded review questions can significantly 
enhance the learning experience.

These features enable zooming into the image of a 
chromosome to get a better look, for instance, or 
rotating a 3-D model of a molecule. Or, an 
interactive graphic might enable you to tap the parts 
of an insect’s body, highlighting them in other 
photos elsewhere on the screen. Switching 
orientations changes the display from a scrolling 
approach (portrait) to a page-based design 
(landscape) with multiple columns and in-text 
graphics.
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The books that Apple showed off included a built-in 
glossary; you can browse through it or tap bolded 
words to look up their definitions in the glossary 
(which can even include images) or in a dictionary. 
Searching remains, of course, and is improved — 
when you tap a word, you can search for it in the 
book, in both text and media (presumably mediated 
by a search index), or extend the search to Wikipedia 
or the Web. If the textbook’s glossary includes the 
word, the glossary entry will also come up as a 
search result.

Another nut that Apple has apparently cracked is that 
of pagination — it’s important in a class for 
everyone to be literally on the same page, and these 
books have fixed pagination in landscape mode. You 
can’t change fonts or sizes in landscape mode, but 
those standard iBooks controls appear once again in 
portrait mode.

More interesting are iBooks 2’s new note-reviewing 
capabilities, which appear to work only in these 
enhanced textbooks. Just as with iBooks previously, 
you can tap and hold or swipe to highlight text, and 
then tap the highlighted text to add a note. But with 
an enhanced textbook, notes can be used in a study 
card format where you see the highlighted text on 
the “front” of a virtual index card and your note on 
the “back,” which you reach by tapping it. The stack 
of cards can even be shuffled to aid in studying for 
tests.

Although iBooks 2 remains a universal app that runs 
on all iOS devices, the iPhone and iPod touch 
versions cannot display these new enhanced books 
(they don’t even appear, which is good, since they’re 
huge). Plus, several times when I tried to view the 
enhanced “Life on Earth” book in iBooks 2 on my 
original iPad, all I got was the introductory audio on 
a gray screen — I had to shut my iPad down and 
restart it before iBooks 2 would show the book 
properly. (Life on Earth is currently available for 
free; it’s a nearly 1 GB download.)

iBooks Author -- Previously, iBooks was relatively 
limited in what it could display, and adding audio 
and video to an EPUB was difficult at best. Creating 
these enhanced ebooks is where the second new app 
— iBooks Author — comes in. It’s a Mac 
application, available for free from the Mac App 
Store as a 136 MB download, and compatible only 
with Mac OS X 10.7 Lion. (It turns out that iBooks 
Author can be run in 10.6 Snow Leopard, but doing 
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so requires some trickery. Digital Tweaker has the 
details.)

Not surprisingly, iBooks Author is reminiscent of 
Apple’s iWork applications, providing a number of 
templates to start. As in Keynote, you add pages to 
your book, putting text, graphics, and multimedia 
elements on each. You can import text from Pages or 
Word, and iBooks Author honors a set of styles for 
creating items such as headings, sections, and so on. 
You can even import Keynote presentations as 
interactive elements.

Like Pages, iBooks Author can build the table of 
contents automatically, based on styles that you use 
for headings in the manuscript, and you can create 
glossary entries from the Glossary toolbar or by 
Control-clicking a term and choosing from the 
contextual menu. Then you bounce over to the 
Glossary interface to enter a definition.

Unfortunately, iBooks Author doesn’t appear to have 
the change tracking and commenting tools that are 
necessary in any professional publishing situation, 
which means that text will have be pretty much final 
when it is flowed into iBooks Author, and any 
collaboration on layout and object placement will 
have to be done manually.

iBooks Author can export three types of files: text, 
PDF, and iBooks. The text export is likely only for 
extracting text from an existing file, the PDF export 
appears to be useful only for a certain level of 
proofing, and the iBooks format is apparently EPUB, 
with a slightly different MIME type (drop one on 
BBEdit if you want to look inside). You can export 
directly to a connected iPad for testing, which is far 

easier than the normal convoluted process for 
syncing ebooks to the iPad.

However, don’t get your hopes up for being able to 
use iBooks Author for EPUB in general — the 
license agreement states that files created with 
iBooks Author must either be made available for free 
or sold only through the iBookstore, and they will 
likely display only in iBooks on the iPad without 
some hacking. In short, if TidBITS wanted to create 
an enhanced Take Control ebook using iBooks 
Author, the only way for readers to purchase it 
would be through the iBookstore, which makes it 
much harder for us to communicate with readers and 
provide outside-the-book features as we do now. It 
would also make it harder for us to provide a similar 
ebook in other formats, such as one that can be read 
directly on the Mac or on the Kindle. We might try 
iBooks Author, but given the low impact the 
iBookstore has had on sales for us so far, it won’t be 
a sea change for our publishing model.

iTunes U -- Apple’s third app — which requires iOS 
5 and is available for not only the iPad but also the 
iPhone and iPod touch — does for online course 
content what iBooks 2 does for textbooks. Apple has 
long provided lectures from numerous colleges and 
universities in audio and video format via iTunes U, 
and with over 700 million downloads, it has been 
successful. The iTunes U app can play the simple 
audio and video for existing courses, but it gets far 
more interesting when used with a newly enhanced 
course (it also gets flakier — as with iBooks 2, I 
experienced a number of crashes; you can expect 
minor updates to both apps as Apple works out the 
bugs). If you want a sample, check out Duke’s Core 
Concepts in Chemistry.

The iTunes U app breaks an enhanced course into 
four sections: Info, Posts, Notes, and Materials, and 
you switch between them using tabs on the right side 
of the screen (iPad) or bottom of the screen (iPhone/
iPod touch). The Info tab provides subsections for 
things like a course overview, an instructor bio, and 
the outline of the course.
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The heart of the course lies in the Posts tab, which 
brings together text, audio, and video lectures and 
assignments, along with the new enhanced ebooks 
created with iBooks Author (which can be read only 
on an iPad, remember). Although the Core Concepts 
in Chemistry course I looked at seemed fully fleshed 
out, for courses that are in progress, new posts alert 
you to their presence via notifications. You can even 
play an audio or video lecture and listen in the 
background while in a different part of the interface, 
such as the Notes tab. When you complete an 
assignment, you can check it off.

In the Notes tab, you can create general course-level 
notes, and any notes from iBooks that are part of the 
class will appear as well. (But remember, you can 
make notes only on EPUB-based ebooks; although 
iBooks can display PDFs, which will be common in 
courses, you can’t make notes on those.) Those 
books may appear within the assignments, and 
they’re all collected in the Materials tab as well. The 

course includes (or will download) all the core 
materials, but some supplemental materials, 
including books and apps, may require additional 
purchases.

How one creates an iTunes U course was not shared, 
although Apple said that six schools have had access 
to the new tools and have created over 100 new 
online courses. We’d like to see Apple open up the 
tools necessary to create an iTunes U course, just 
like iBooks Author, such that it would be possible to 
create — and sell — training courses via iTunes, 
although that gets back into the single-store debate.

Ironically, the presence of all this information online 
may reduce attendance in classes even further, 
something we’ve heard professors in iTunes U 
lectures complain about with the ready availability 
of recorded lectures.

A more speculative question is what will happen — 
particularly in certain subjects where collaborative 
scenarios or access to specialized equipment aren’t 
important — to higher education in general if it 
becomes possible to take most courses online in this 
fashion. Will the intangibles of a college education 
— maturation, networking, exposure to opportunities 
— and the eventual diploma be seen as worth the 
skyrocketing tuition costs?

An Apple a Day for Education -- I’ll give Apple 
this — they don’t think small. These apps set a new 
standard for electronic books and online courses, and 
the apps are all available for free. The problem is 
that Apple also wants to own the entire pie, and in 
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the process say exactly what is and is not possible. 
That’s not particularly different from Amazon, which 
tries to lock works into the Kindle ecosystem by 
refusing to support EPUB. But at least the far-less-
ambitious Kindle format can be converted to from 
other formats.

Debates are already raging on Twitter about how 
iBooks Author doesn’t allow works created with it to 
be sold anywhere but the iBookstore, and we 
publisher types are already trying to imagine how we 
can justify the extra effort and expense of creating 
enhanced ebooks for a single retail outlet. Plus, 
Apple is talking about these textbooks being 
inexpensive — on the order of $14.99 — which may 
play havoc with publisher business models that rely 
on high prices for books that are reused for multiple 
years. How it will shake out in the publishing world 
remains to be seen.

On the other side of the equation are the schools — 
where will the budget come from to outfit students 
with iPads and to buy these textbooks? It’s not 
impossible — we know of some local school 
districts that have had great success with pilot 
programs for tablets (Android, in this case), both in 
terms of student achievement and cost savings. But 
many schools can purchase only state- or district-
approved textbooks, and that’s where Apple’s 
connection with publishers may be key — it should 
be much easier for a government entity to approve 
an electronic textbook if it is simply the electronic 
version of an approved traditional textbook.
This article is copyright © 2012 Adam C. Engst, TidBITS is 
copyright © 2012 TidBITS Publishing Inc. Reuse governed by 
Creative Commons License.

Hot Links:
Compiled by Tom Ostertag

Apple, Inc.

Watch Apple’s Approach To Reinventing 
Education [Video] from Cult of Mac

Mac Software

Apple's new iBooks Author from AppleInsider

10.7: Setting duration before files are locked from 
MacOSXHints.com

iOS Device Screenshots & iPhoto Smart Albums 
from MacOSXHints.com

Mac Hardware

Apple Working To Adopt 802.11ac 5G Gigabit WiFi 
This Year from AppleInsider

Does It Make Sense For The Apple TV To Become A 
DVR Too? From Infinite Loop

iPad

Apple Reinvents Textbooks with iBooks 2 for iPad 
from Apple Hot News

iPod/iPhone/iTunes

New iTunes U App for iPad, iPhone, and iPod touch 
from Apple Hot News

Apple releases iTunes 10.5.3 with iBooks 2 textbook 
syncing from AppleInsider

Free on iTunes: 3 Free iOS Apps for The Reader, 
The Dreamer, & The Planner | The Mac Observer

Miscellaneous

How-To: How to Combine Multiple PDFs Using 
Preview | The Mac Observer

How To Download Just About Anything [OS X Tips] 
from Cult of Mac

Everything You Ever Need To Know About Your Mac 
Can Be Found Here | EveryMac.com

mini’app’les Newsletter — February 2012 Page 17 of 20

http://tidbits.com/author/Adam%20C.%20Engst
http://tidbits.com/author/Adam%20C.%20Engst
http://tidbits.com/terms/
http://tidbits.com/terms/
mailto:tostertag@usfamily.net?subject=Hot%20Links
mailto:tostertag@usfamily.net?subject=Hot%20Links
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/zQNjVHg393c/story01.htm
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/zQNjVHg393c/story01.htm
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/zQNjVHg393c/story01.htm
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/zQNjVHg393c/story01.htm
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.feedburner.com%2Fcultofmac%2FbFow
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.feedburner.com%2Fcultofmac%2FbFow
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf737b1/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Cfirst0Ilook0Iapples0Inew0Iibooks0Iauthor0I0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf737b1/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Cfirst0Ilook0Iapples0Inew0Iibooks0Iauthor0I0Bhtml/story01.htm
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://feeds.macosxhints.com/click.phdo?i=f1d314831f5b42c8fc238fa98e97c577
http://feeds.macosxhints.com/click.phdo?i=f1d314831f5b42c8fc238fa98e97c577
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.macosxhints.com%2Fmacosxhints%2Frecent
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.macosxhints.com%2Fmacosxhints%2Frecent
http://feeds.macosxhints.com/click.phdo?i=3b990c2a91ef611764d0276bdde1a4cc
http://feeds.macosxhints.com/click.phdo?i=3b990c2a91ef611764d0276bdde1a4cc
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.macosxhints.com%2Fmacosxhints%2Frecent
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.macosxhints.com%2Fmacosxhints%2Frecent
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1c061a12/l/0L0Sappleinsider0N0Carticles0C120C0A10C210Capple0Iworking0Ito0Iadopt0I80A211ac0I5g0Igigabit0Iwifi0Ithis0Iyear0I0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1c061a12/l/0L0Sappleinsider0N0Carticles0C120C0A10C210Capple0Iworking0Ito0Iadopt0I80A211ac0I5g0Igigabit0Iwifi0Ithis0Iyear0I0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1c061a12/l/0L0Sappleinsider0N0Carticles0C120C0A10C210Capple0Iworking0Ito0Iadopt0I80A211ac0I5g0Igigabit0Iwifi0Ithis0Iyear0I0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1c061a12/l/0L0Sappleinsider0N0Carticles0C120C0A10C210Capple0Iworking0Ito0Iadopt0I80A211ac0I5g0Igigabit0Iwifi0Ithis0Iyear0I0Bhtml/story01.htm
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/SVdiqwRrdhQ/does-it-make-sense-for-the-apple-tv-to-become-a-dvr-too.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/SVdiqwRrdhQ/does-it-make-sense-for-the-apple-tv-to-become-a-dvr-too.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/SVdiqwRrdhQ/does-it-make-sense-for-the-apple-tv-to-become-a-dvr-too.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/SVdiqwRrdhQ/does-it-make-sense-for-the-apple-tv-to-become-a-dvr-too.ars
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.arstechnica.com%2Farstechnica%2Fapple%3Fformat%3Dxml
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.arstechnica.com%2Farstechnica%2Fapple%3Fformat%3Dxml
http://www.apple.com/education/ibooks-textbooks/?sr=hotnews.rss
http://www.apple.com/education/ibooks-textbooks/?sr=hotnews.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fimages.apple.com%2Fmain%2Frss%2Fhotnews%2Fhotnews.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fimages.apple.com%2Fmain%2Frss%2Fhotnews%2Fhotnews.rss
http://www.apple.com/education/itunes-u/?sr=hotnews.rss
http://www.apple.com/education/itunes-u/?sr=hotnews.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fimages.apple.com%2Fmain%2Frss%2Fhotnews%2Fhotnews.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fimages.apple.com%2Fmain%2Frss%2Fhotnews%2Fhotnews.rss
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf78b47/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Capple0Ireleases0Iitunes0I10A530Iwith0Iibooks0I20Itextbook0Isyncing0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf78b47/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Capple0Ireleases0Iitunes0I10A530Iwith0Iibooks0I20Itextbook0Isyncing0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf78b47/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Capple0Ireleases0Iitunes0I10A530Iwith0Iibooks0I20Itextbook0Isyncing0Bhtml/story01.htm
http://appleinsider.com.feedsportal.com/c/33975/f/616168/s/1bf78b47/l/0L0Sappleinsider0N0Carticles0C120C0A10C190Capple0Ireleases0Iitunes0I10A530Iwith0Iibooks0I20Itextbook0Isyncing0Bhtml/story01.htm
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.appleinsider.com%2Fappleinsider.rss
http://www.pheedcontent.com/click.phdo?i=533b1d047e09ef9a6ba67d0407c5ceed
http://www.pheedcontent.com/click.phdo?i=533b1d047e09ef9a6ba67d0407c5ceed
http://www.pheedcontent.com/click.phdo?i=533b1d047e09ef9a6ba67d0407c5ceed
http://www.pheedcontent.com/click.phdo?i=533b1d047e09ef9a6ba67d0407c5ceed
http://www.pheedcontent.com/click.phdo?i=b509b63e5da42baf262359f7593772f5
http://www.pheedcontent.com/click.phdo?i=b509b63e5da42baf262359f7593772f5
http://www.pheedcontent.com/click.phdo?i=b509b63e5da42baf262359f7593772f5
http://www.pheedcontent.com/click.phdo?i=b509b63e5da42baf262359f7593772f5
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.macobserver.com%2Ftmo%2Frss%2Feverything%2F
http://www.google.com/reader/view/feed/http%3A%2F%2Fwww.macobserver.com%2Ftmo%2Frss%2Feverything%2F
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/0vGiEemlDBs/story01.htm
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/0vGiEemlDBs/story01.htm
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.feedburner.com%2Fcultofmac%2FbFow
http://www.google.com/reader/view/feed/http%3A%2F%2Ffeeds.feedburner.com%2Fcultofmac%2FbFow
http://www.everymac.com/
http://www.everymac.com/
http://www.everymac.com/
http://www.everymac.com/


Members Helping Members
Need Help? Have a question the manual doesn’t 
answer? Members Helping Members is a group of 
volunteers who have generously agreed to help. 
They are just a phone call or an email away. Please 

call only during the appropriate times, and only if 
you are a current mini’app’les member and own 
the software in question.

...................Apple II / IIGS Software & Hardware NV
....................................AppleWorks / ClarisWorks 3, 4

..........................................................Classic Macs NV
.................................Cross-Platform File Transfer 2, 3

........................................................FileMaker Pro NV
.....................................................................iMacs NV

...................................................Intel-Based Macs NV
.........................................................................iPhoto 3
........................................................................iMovie 6
.........................................................................iWork 4

.........................................................Mac OS Classic 3

..............................................................Mac OS X NV
.....................................................Microsoft Excel 2, 5
......................................................Microsoft Word 2, 5

................................................................Networks NV
.................................................................New Users 1
..............................................................PhotoShop NV

..............................................................QuarkXPress 5
..................................................................Quicken NV

.........................QuickBooks and QuickBooks Pro NV
..........................................................VectorWorks NV

1. Les Anderson 651-735-3953 anderslc@usfamily.net DEW
2. Tom Ostertag 651-488-9979 tostertag@q.com DEW
3. Bruce Thompson 763-546-1088 bthompson@macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ron Heck 651-774-9151 ronheck@comcast.net DEW

D = Days, generally 9 a.m. to 5 p.m.
E = Evenings, generally 5 p.m. to 9 p.m.
W= Weekends, generally 1 p.m. to 9 p.m.
NV = No Volunteer

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of these 
volunteers can also be contacted on our forums. We appreciate your cooperation.

Mini’app’les needs more volunteers for Members Helping Members — If you are willing to 
be a Members Helping Members volunteer, please send an email message to Membership Director Les 
Anderson or contact him on our forums with your name, telephone number, contact hours, and the 
software and hardware areas you are willing to support.
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Mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. To pay electronically using PayPal, visit the mini’app’les website.

If you prefer to pay by check, use the form below. Please make your check payable to “mini’app’les”.

Name:   

Company (if mailed to):   

Address:  

City, State, Zip:   

Phone # (home):   

Phone # (work):   

Phone # (cell):   

Membership ID # (if renewal):   

Email:   
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution 
of the newsletter and membership renewal reminders.

  Check if this is a change of address notice

  Check if you want to volunteer

  Check if you want to be added to “Members Helping Members”

  Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting, 
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

• Access to our Members Helping Members network of professional and advanced users of Apple technologies. 
These members volunteer their time to help other members with software, hardware, and other Apple related 
issues.

• A variety of Mac Special Interest Groups (SIGs) that meet each month.

• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment 
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

• Participation in drawings for computer hardware, software, and other computer related materials.

• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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mini’app’les
the minnesota apple computer users’ group, inc.

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group, Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted © by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups’ publications except where specifically copyrighted 
by the author (permission to reproduce these articles must be 
given by the author). Please include the source when reprinting.

The mini’app’les Newsletter is an independent publication not 
affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and 
views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or 
views of Apple, Inc., or any other computer manufacturer. 
Instead of placing a trademark symbol at every occurrence of a 
trade-marked name, we state we are using the names only in an 
editorial manner, to the benefit of the trademark owner, with no 
intention of infringement of the trademark.

Questions — Members with technical questions should refer to 
the Members Helping Members section or bring their questions 
to an appropriate SIG meeting. Please direct other questions to 
an appropriate board member. 

Dealers — Mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf of 
other members.

Submissions — We welcome contributions from our members. 
Perhaps you’re using new software that you just can’t live 
without. Maybe you have a new piece of hardware that you find 
extremely useful and of high quality. On the other hand, you 
might be struggling with problematic software or hardware.
Why not share your experience with other members by writing a 
product review? Doing so may steer others towards quality 
products or help them avoid the problems you may be having.

Submissions must be received by the 15th day of each month to 
be included in the next month’s newsletter. Please send 
contributions directly to our post office box (mini’app’les, PO 
Box 796, Hopkins MN 55343), or email them to 
miniapples@mac.com.

The deadline for material for the next newsletter is the fifteenth 
of the month. An article will be printed when space permits and, 
if in the opinion of the Newsletter Editor or Publications 
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word 
processor.

Board of Directors

President Tim Drenk
 952-479-0891
 timdrenk@miniapples.org

Vice President Jeff Berg
 781-350-0598
 jeff@purpleshark.com

Secretary Joel Gerdeen
 763-607-0906
 jgerdeen@mac.com

Treasurer Bob Demeules
 763-559-1124
 osx.sig@mac.com

Membership Director Les Anderson
 651-735-3953
 anderslc@usfamily.net

Publications Director Tom Ostertag
 651-488-9979
 tostertag@q.com

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Membership Sandy Foderick
Coordinator sfoderick@mac.com
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